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Notes of the Employment Roundtable, October 8
Our October chapter meeting consisted of
roundtable discussions on becoming em-
ployed. The meeting, held at Duranti’s res-
taurant, was preceded by dinner. Eight STC
and outside experts then stationed them-
selves at separate tables, and attendees
moved among the tables. There was
enough time for each person to hear five
discussions. Each talk is summarized in a
separate article in this newsletter.

Interviewing – John Clark

By Jim McCarty

John Clark led an exciting and lively dis-
cussion on polishing interviewing tech-
niques … complete with role playing!

Why should we be concerned with inter-
viewing? John suggests that jobs go to the
people who do the best job of selling them-
selves, not necessarily those who are most
qualified.  Success comes from being well
prepared, anticipating questions, and pre-
paring solid answers to those questions.

Do you know the first question asked by
most interviewers? It is usually some ver-
sion of  “Tell me about yourself”. Knowing
this, you should have a strong “commer-
cial” about yourself already prepared. Be
prepared to cover your background, accom-
plishments, and ambitions, including where
you are and what you are looking for. Keep
it brief; your opening statement, just like all
of your answers, should be between 20 and
90 seconds.

During the interview, phrase your answers
in a way that will elicit a positive response

from the interviewer. Creating a positive
image with the interviewer is the first step
towards getting a job offer. Give answers
that show how you can contribute, using
examples from your experience. Do your
homework. Tailor your answers to the
needs and desires of the employer.

When discussing your accomplishments,
structure your answers following the “S-
A-R” format. Describe the Situation you
faced, the Action you took to solve the prob-
lem, and the Result of that action.

What type of questions should you antici-
pate? John believes that of all the ques-
tions that you could face, most interviews
center around five basic questions:

1. Why you?

2. Why this company?

3. What can you do for us?

4. How do you fit in with us?

5. How can we afford you?

Don’t talk about money until you’re sure
that there’s a good fit. The more they like
you the stronger your negotiating power.

Do you need time to collect your thoughts
when asked a tough question? Repeat the
question (while thinking about it) with a
preface like “Let me make sure I understand
your question,” then paraphrase the ques-
tion. But don’t be afraid to pause and think.
It’s OK not to appear too polished. Remem-
ber that the interviewer is probably just as
nervous as you are.

The key to preparing for an interview is
role playing. Develop a list of potential

questions, then prepare and rehearse your
answers to those questions. Role play with
someone asking you the questions ran-
domly. Give your best direct, succinct,
positive answer. Then ask them to critique
your response. You will most likely learn
more from this exercise than from any other
preparation you could do.

Would you like more help? John has pre-
pared a list of frequently asked, hard-hit-
ting questions that you should have ready
answers for, as well as a resource list on
interviewing that can help you prepare.
Contact John at clarkenter@attbi.com and
he will email you his notes along with an
interviewing resource list.

(continued on page 4)
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The calendar year may be winding down,
but activity in the STC is showing no signs
of slowing.

First of all, it is time to renew your member-
ship for the 2003 calendar year. Each mem-
ber whose email address is on file with the
national STC office should have received
an invitation to renew online. Please renew
early and online if at all possible. The Soci-
ety will save the cost of mailing physical
renewal notices to those who renew online
by mid-November.

Don’t forget the Region 4 Conference,
coming up November 8 and 9. (Official
registration deadline is October 31.) Con-
ference information is available at http://
www.centralohiostc.org/region4conf/.
We are proud to have five members of the
WorkQuest group attend the conference
to present about the group.

WorkQuest(TM) is continuing to meet the
needs of technical communicators who are
seeking employment. For information about
WorkQuest, contact Janis Ramey at
ramey@technical-writing.net or 412-833-5548.

President’s Column
In other news, we are expending the scope
of our Consulting and Independent Con-
tracting SIG. Because of the diversity of
attendees, and to serve the interest of
more of our chapter members, the group
is now the Independent and Lone Writer
SIG. For information about the group,
please contact Barb Stanton via
Bstanton@SEEC.com, or 412-893-0383.
The Pittsburgh Chapter is grateful to Barb
for her enthusiasm in running the SIG.

Our annual employment roundtable in Oc-
tober continued its streak as one of our
most popular meetings. The Pittsburgh
chapter thanks all of the people who agreed
to share their expertise.

The regular chapter meeting is on Wednes-
day, November 6. This month’s meeting will
feature a vendor presentation by
Quadralay, a maker of tools to facilitate
single-source publishing from FrameMaker
and Microsoft Word. See the last page of
the newsletter for meeting details.  I hope
to see each of you there!

Writing an Effective Résumé
By Mary Ann Pike

In today’s market, there are so many people
applying for each open position that it’s nec-
essary to make your résumé as attractive as
possible to potential employers. To deal with
the volume of résumés, many employers are
resorting to computerized keyword matching.
Even when the résumés are being reviewed
by hand, the average human resources per-
son only spends 20 seconds evaluating a
résumé. Here are some hints for getting your
résumé noticed.

Résumé Formatting Tips
• Put a summary of your experience and

strong skills in a brief paragraph at the
beginning of the résumé.

• List your technical skills at the begin-
ning since, unfortunately, people are
often looking at your tools experience
instead of your writing skill. Be sure to
include all of the technical skills you’ve

acquired, even if they are not directly
related to writing (experience with Visio,
Access, and Excel, for example).

• Put all of your contact information up
front. If you have a web site that con-
tains samples of your work, make sure
the web address is on the résumé.

• List all awards, certifications, and edu-
cational experience you have. If you’ve
been out of school for a long time, you
probably want to put your educational
background towards the end of your
résumé, but if you have taken recent
classes or seminars in new technolo-
gies, be sure to list them.

• Use emphasis effectively to draw at-
tention to important items.

• Create a presentation package to leave
with prospective employers.

(continued on page 6)
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STC Offering Telephone Seminars
STC is offering ten telephone seminars in
2002 - 2003.  Beginning November 7th, two
seminars will be offered each month
through March 2003.  Telephone seminars
have been very successful in bringing cost-
effective training to STC members and oth-
ers seeking to improve their skills and
knowledge.

Seminar Schedule
In the first seminar, Constance Billé will dis-
cuss “Getting Into Instructional Design.”
The seminar will be held on November 7th,
from 1:00 - 2:30 p.m. Eastern Standard Time
(see the notice below for details).

The second November seminar is scheduled
for November 19th, from 1:00 - 2:30 p.m. East-
ern Standard Time.  Entitled “Looking, Find-
ing, Searching...How Users Do It,” the semi-
nar will be led by Whitney Quesenbery.

Other seminars scheduled for 2002 - 2003
are:

• December 13, 2002, “Finding Work in
Troubled Times.”  (Douglas Florzak)

• December 17, 2002, “A Brief, Compre-
hensive Indexing Primer.”  (Seth
Maislin)

• January 8, 2003, “Organizing and Lead-
ing a Software User Interface Design
Team.”  (Diane Feldman and Carla
Merrill)

• January 15, 2003, “Using Personas to
Bring Your Users Into the Development
Process.”  (Whitney Quesenbery)

• February 5, 2003, “Creating Persuasive
Executive Summaries.”  (Stacia D.
Kelly)

• February 13, 2003, “Fast and Easy Time
Management.”  (John Hedtke)

• March 12, 2003, “Making the Complex
Clear and Pretty.”  (Phylise Banner)

• March 19, 2003, “Evaluating an Index
(even if you only have five minutes).”
(Seth Maislin)

Registration Information
The cost for each seminar is $145.00 USD
for U.S. sites and $160.00 USD for Cana-
dian sites.  Overseas participants should
contact the STC office.  An additional $10.00
will be charged for registration received less
than five days before the seminar.

For details, including an explanation of how
the telephone seminars work, or how to do
on-line registration, please visit http://
www.stc.org/seminars.asp.  You also may
complete the registration form in the Octo-
ber 2002 Intercom.

As cost-effective and time-efficient ways
of improving your skills and knowledge,
telephone seminars are much like a large
conference call, but in a more controlled
environment.  Simply dial the 800 number
from your telephone, enter the provided
personal identification number, and you’re
connected.  Then sit back and listen to the
presentation and join in the discussions.
For one registration, several employees at
a company may benefit from the seminar
presentation and develop their own inter-
active discussions.

Getting Into Instructional Design –
STC Telephone Seminar
Constance Billé

Chapter Archives
are Updated
Our STC chapter’s archives catalog has been
updated. To see the catalog, see this website—
http://www.technical-writing.net/links/
Contents%20of%20STC%20Archives.htm

 Or go to Janis Ramey’s website (address
below) and click on “Links”.

technical-writing.net

November 7, 2002

1-2:30 PM Eastern Standard Time

Are you ready for a move into the challeng-
ing and creative field of Instructional Design? 
In this seminar we will use a self-assessment
exercise to help you understand your current
skill set and readiness for the move.  How
does Instructional Design differ from related
careers?  We will compare the skill sets asso-
ciated with related fields and review sample
resumes to illustrate a candidate’s “fit” with
Instructional Design.  What organizations

can help you develop the skills and con-
tacts you will need to make the career tran-
sition?  What should you look for in higher
education programs that can help you gain
the knowledge and skills needed?  What
tools are most valuable for an Instructional
Designer?  How can you develop a strat-
egy to move into the instructional design
field from where you are right now?

This seminar is appropriate for any STC
member interested in a career in instructional
design.
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People News

Society for Technical Communication

Pittsburgh Chapter
P.O. Box 133
Pittsburgh, PA 15230
Contact: Alan Houser
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Four Chapter Members in the News
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Welcome New MembersWelcome New MembersWelcome New MembersWelcome New MembersWelcome New Members

Mark HymanMark HymanMark HymanMark HymanMark Hyman

William J. SaulsWilliam J. SaulsWilliam J. SaulsWilliam J. SaulsWilliam J. Sauls

The weekly Pittsburgh Business Times in-
terviewed four members of the STC Pitts-
burgh Chapter regarding the state of the
economy for technical writers: Janis Ramey
(Ramey Technical Writing), Alan Houser
(Group Wellesley), Joyce Query

(TechWrite), and Trudi Miklos (Ansys).
The article was published in the September
20 print edition (available at major news-
stands), and on the Web at:http://
pittsburgh.bizjournals.com/pittsburgh/sto-
ries/2002/09/23/focus3.html

Résumés — Mary Ann Pike

By Nancy Carpenter

Mary Ann showed samples of printed and
electronic résumés.  Recommended con-
tent consisted of about six bullet points
on your strong skills, a summary, then a
concise list of experience in reverse chro-
nological order.  Include work that shows
initiative, cost savings, quick learning, and
unusual skills.  An experienced worker can
put education next, followed by publica-
tions and awards.  Instead of an objective,
tailor each résumé to the job for which you
are applying.  Include tools you use in
publishing, the computer environment,
computer languages, or other software.
The job resource center at Carnegie
Library’s main branch has invaluable re-
sources on résumés.

Mary Ann gave tips on how to get your
résumé to be noticed in the 20 seconds
that the average human resource person
takes to evaluate it. She discussed format-
ting, content, accuracy, and meeting the
job requirements. Her article entitled,
“Writing an Effective Résumé” goes into
detail on these topics and appears in this
issue of Blue Pencil.

Medical Writing — Diana Mathis

By Nancy Carpenter

Diana discussed entering and keeping
abreast of the medical writing field.  Two or-
ganizations offer certification programs that
can get you started: the American Medical
Writers Association (www.amwa.org or
email amwa@amwa.org) or the Board of
Editors in the Life Sciences (www/bels.org).

You also should check some general and
specific medical journals.  Check their
websites if you do not want to subscribe.
Following are some resources:

•  Stedman’s or Dorland’s medical dic-
tionary

•  Physician’s Desk Reference

•  Pharmaceutical Word Book, Saunders

•  Medical Abbreviations & Eponyms,
Sloane

•  Laboratory Tests and Diagnostic Pro-
cedures, Chernecky and Berger

•  AMA Manual of Style, Lippincott, Wil-
liams & Wilkins

•  CBE Scientific Style and Format,
Council of Science Editors, Chicago,
IL

•  Medical English Usage and Abusage,
Edith Schwager, Oryx Press

•  Health Writer’s Handbook, Barbara
Gastel, MD, Iowa State U. Press

•  How to Write and Publish Papers in
the Medical Sciences, Edward Huth,
MD, ISI Press

•  How to Write and Publish a Scientific
Paper, Robert Day, PhD, ISI Press

•  Internal Medicine, either Stein’s 5th
ed., or Harrison’s of Cecil’s

•  Merck Manual

•  Anatomy and Physiology, Martini or
Gray’s

•  Council of Science Editors at http:/
www.councilscienceeditors.org

Life as a Technical Communications
Consultant — Alan Houser

By Nancy Carpenter

Alan advises that your two biggest chal-
lenges at startup and throughout your ca-
reer are finding work and deciding what to
charge. Your first jobs will come from people
you know, so if you do not know someone
with work, do not start a consulting busi-
ness. It is best to build up three to six

Notes of the Employment Roundtable
(continued from page 1)

(Continued on page 8)

mailto:clarkenter@attbi.com
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Extracting Document Content—With Style
By Robert P. Mohr

Do you ever have documents containing certain content ele-
ments that you wish you could extract without going through the
agony of repeated copy and paste operations? For example,
wouldn’t it be nice to have the ability to extract just the require-
ments out of a Software Requirements Specification? Once ex-
tracted from the original document, the requirements could then
be moved into a spreadsheet or imported to a database. But how
do you extract them? The solution is surprisingly simple: All you
need is style.

Word’s paragraph styles and its configurable table of contents
feature makes it relatively simple to extract paragraphs from a
document. Naturally, a little preplanning will make the job easier.
Let’s suppose you are going to create a Software Requirements
Specification. The spec will contain dozens of specific require-
ment statements scattered throughout a 50-page document packed
with tables, graphics, and other paragraphs of text.

The first thing to do is to create the page layout and the styles for
the basic structure, (i.e., headings, subheadings, body text, bul-
lets, numbered steps, captions, etc.).  Then create a style for the
requirements paragraphs. This style can be as simple or as elabo-
rate as you want. The key is that all requirements are formatted
with the requirement style. If they’re not, the extraction process
will not work. With the document’s basic design finished, the
content can be added. For example:

Requirements spec body text goes here. Requirements spec body
text goes here. Requirements spec body text goes here. Require-
ments spec body text goes here. Requirements spec body text
goes here. Requirements spec body text goes here. Requirements
spec body text goes here.

REQ-1001-022 Requirement text goes here; apply
“Requirement” style.

REQ-1001-023 Requirement text goes here; apply
“Requirement” style.

REQ-1001-024 Requirement text goes here; apply
“Requirement” style.

Requirements spec body text goes here. Requirements spec body
text goes here. Requirements spec body text goes here. Require-
ments spec body text goes here. Requirements spec body text
goes here. Requirements spec body text goes here. Requirements
spec body text goes here.

Notice the tab and hanging indent separating the requirement
number from the requirement text. This is very important and will
come into play later on. Once the requirements specification docu-
ment has been saved, and at any time thereafter, you can extract
just the requirements paragraphs.

Several steps are necessary to set up a new document to hold the
extracted requirement text. However, once the document has been
created, “refreshing” it with updated requirement text requires only
three mouse clicks. Here’s how to set up a document to hold the
extracted content:

1. Create a new document file.

2. Create the same Requirement style in this document as you did
in the requirements specification doc.

3. Add any headers, footers, and content as needed.

4. Select Tools > Options > View from the main menu.

5. Toggle ON, Field Codes and Hidden Text.

6. Click OK.

7. Position the insertion point in the document where you want
the list of requirements to begin.

8. Select Insert > Field. The Field dialog box is displayed.

Fig. 1

9. Select the RD field and enter the name of the file containing
the requirements in the Filename box. (Fig. 1)

10. Click OK. You should see a code in your document similar to
the following:

{RD “SRS-01.doc” }

11. Press Enter to create a new line.

12. Select Insert > Reference > Index and Tables. The Index and
Tables dialog box is displayed (Fig. 3).

(Continued on page 11)
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• Send your résumé in something other
than a plain envelope. Use a large en-
velope, color, Federal Express, etc. to
stand out from the other applicants.

Résumé Content Tips
• List your work history. Chronological

order is usually the accepted format,
but if you feel that your length of expe-
rience would be a detriment to your
job search, you can list your experi-
ence by function.

• List ways in which you’ve added value
to the projects on which you’ve
worked. If you have saved the com-
pany money or improved their produc-
tion time, say so.  Include examples of
recognition you received.

• Use action verbs to describe your ex-
perience. Present the material in short
concise sentences.

• Include information about skills not
directly related to writing:
- Are you good at public speaking?

Writing an Effective Résumé
(continued from page 2)

- Have you conducted professional
seminars?

- Do you have any articles pub-
lished?

- Have been through management
training?

- Have you supervised people?
How many?

- Are you active in any professional
societies?

- Did you initiate any new projects?
- Are you proficient in a foreign lan-

guage?
- Are you a skilled photographer?

• Be honest, don’t exaggerate, but re-
member that you are selling yourself.

• Try to emphasize that you are a team
player, but can lead.

Refinement Tips
• Keep your résumé up to date.

• Make sure your résumé is correct in
both spelling and grammar. This is criti-
cal when applying for writing positions.

• Have someone else evaluate your
résumé and give you comments. Try
the 20 second test and see what they
remember most about you.

• Have different résumés adapted for dif-
ferent industries or different job posi-
tions. Put the experience that is most
applicable to the job you’re applying
for at the front of your résumé.

• Look at the résumés of other people.
See how they are formatted and what
you remember from them.

• Have an online version of your résumé
on a web site so that prospective em-
ployers can see more than just text.

• Put your portfolio (or selected items) on
a web site so you can refer to them in an
e-mail message or when speaking to pro-
spective employers on the telephone.

Other Tips
• Submit your résumé in the format re-

quested. Many people accept or even

require Microsoft Word format, but
some people want a text version pasted
into an email message because they
are afraid of viruses. Prepare a decent
looking text version of your résumé and
keep it up to date.

• Whenever possible, create a custom
cover letter for each application. Ad-
dress the cover letter to a specific per-
son if known.

• Keep track of where you have sent your
résumé and what version you sent
them, including cover letters.

• Use all available resources:
- Carnegie Library Job & Career

Education Center
- Books from a bookstore
- University career placement of-

fices
- Networking groups such as STC

WorkQuest™, PAPEN
- Professional organizations
- Volunteer organizations
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Employment Issues: Interview Tips
By Pam Schmidbauer
Area Manager, Aquent

In this uncertain job climate many people
are looking for their next position. When
interviewing for a job, give yourself every
chance to make a good impression. Here
are some guidelines to help make the most
of every opportunity.

Be a little early
Make absolutely sure that you know how
to get to the interview and how long the
trip will take. Take traffic into account as
well. Arriving about fifteen minutes before
the scheduled time shows that you’re punc-
tual, reliable, and interested. Another rea-
son to arrive at the interview early is the
possibility that you will have to go through
security or fill out an application. You don’t
want these procedures taking up important
interview time. (If you can, find out about
these issues in advance.)

Make a good first impression
The most important part of the interview is
the first five minutes. One of the most pow-
erful things you can do is to be strong, posi-
tive, and confident. Be aware of your body
language and take care how you phrase

things when responding to questions. It may
be beneficial to rehearse tough questions
with a friend beforehand. Most important,
be yourself and state, but don’t exaggerate,
your accomplishments. Another tip – don’t
give a “dead fish” handshake.

Dress for success
Dress appropriately; don’t dress sloppily,
over dress or under dress. Keep cologne,
make-up and jewelry to a minimum. Prepare
your clothing the night before. Inspect it
for wrinkles, rips, or missing buttons.

Do your homework
Research the company before going on the
interview. You can get excellent information
from the Web or from people who work for
that company. The more you know, the more
you’ll be able to discuss what’s important
to them and assess whether it’s the right fit
for you.

Avoid distractions
Make sure you get a good night’s sleep. You
don’t want to be yawning during an inter-
view. Eat before your interview as well. That
way you won’t be distracted by simply be-
ing hungry and worrying that your inter-
viewer is going to hear your stomach growl.

Take extra résumés
Always take additional copies of your
résumé with you so you have enough cop-
ies for every interviewer. Also remember to
take a copy of your references so they can
start calling them.

Take writing samples
It’s not a bad idea to have additional copies
of your writing samples. You don’t want
the interviewer to have to leave the inter-
view to make copies.

Always ask questions
When you are given an opportunity to ask
questions, make the most of it. Even it you’re
interviewed by five people, have some ques-
tions for each. It shows you’re interested
and observant. Always listen carefully to
their responses.

Here are a few questions that may impress
the interviewer as well as help you assess a
job offer:

• What is the greatest challenge that a
person moving into this position is
likely to face in the first year?

• Why was this job created? Or, why is
this job open?

• How would you (the interviewer) like
to see this department grow and evolve
over time?

• What are the company’s and this
department’s top priorities now?

• Of all the responsibilities I would be
assuming in this job, which are the
most critical?

• If I were employed, where would you
want to see me focus my efforts during
the first few weeks?

Avoid bringing up the subject of salary,
benefits, or holidays. If the interviewer

(continued on page 12)

(continued on page 12)
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months of capital before you start, and to
start while you still have a full-time job.
Keep track of your network.  Eventually,
referrals will add to your business.  To find
an acceptable charge rate, find out what
your present employer pays its consultants
in related fields.  One formula is (your an-
nual salary) / 1000 = hourly rate.

Be conscious of how you present yourself.
Do you want a distinctive email address, a
business machine or fax line, a home of-
fice?  Keep up-to-date with area business
developments and attend networking
events.  Following are some resources:

•  Pittsburgh Post-Gazette, business sec-
tion (http://www.post-gazette.com/)

• Pittsburgh Business Times (http://
www.bizjournals.com/pittsburgh/)

• T.E.Q., newsletter of the Pittsburgh
Technology Council (http://
www.pghtech.org/news/teq/)

• Making Money in Technical Writing
by Peter Kent, 1998, Macmillan, USA

•  Pittsburgh Technology Council  (http:/
/www.techcenter-pgh.com)

• Carnegie Library, Library Center, down-
town business branch (http://
www.clpgh.org/clp/libctr/)

•  Small Business Administration (http:/
/www.sbaonline.sba.gov/)

• Duquesne University Small Business
Development Center (http://
www.duq.edu.sbdc)

• Duquesne University Entrepreneur’s
Growth Conference held annually in June

The Chance to Fail: How to Get Started in
Freelancing — Mary Ecsedy

By Nancy Carpenter

Mary described the way in which she has
tried to systematically learn from mistakes.
She approaches failure as a strategy.  She
keeps a log of mistakes, and here are a few
of them:

•  Never work without a written agreement.

• Never extend more credit (do more un-
paid work) than you can afford to lose.

• Keep bookkeeping up to date.

• Make regular backups.

• Get out of the home-office occasion-
ally.

• Eat and exercise regularly.

•  Set money aside for taxes, savings, va-
cation, sick time.

•  Request a test run on expensive print-
ing jobs.

• Minimize your on-site visits.

• Spend time every week on activities
that generate job leads.

•  Keep control or review power over the
final product.

• Limit your preliminary discussion, es-
pecially if it amounts to free work.

• Don’t indulge in false economies such
as cheap but bad office furniture.

• Bill for good honest service.  Don’t
nickel and dime the client.

Mary advises that we learn from small steps.
For instance, set up interviews to practice
that skill.  Take a part-time contract to see if
freelance work suits you.  This teaches you
two things – how to do two different types
of work simultaneously, and how to toler-
ate working a lot of overtime.

Chapter SIGS — Barb Stanton (Lone
Writer and Independent Contracting),
Janis Ramey (WorkQuest)

By Nancy Carpenter

SIGs that are registered with the national
STC office receive space on the website,
publish a newsletter, and maintain a listserv.
All this for a membership fee of $5 per year.

Barb chairs the combined Lone Writers and
Independents SIG.  The group has been
meeting regularly and educating one an-
other on how to run a successful small busi-
ness.  The meetings alternate between a
formal presentation on a key issue, and an

informal discussion among members.  Last
month Walt Becker, from the Pittsburgh
chapter of SCORE (Service Corp of Retired
Executives) discussed starting a home-
based business, developing and writing a
business plan, marketing and networking,
accounting and invoicing, paying taxes, and
continuing growth.  Following are some re-
sources:

•  Pittsburgh Small Business Association
(http://www.sba.gov/pa/pitt/)

• Small Business Association (http://
www.sba.gov)

• SCORE – Service Core of Retired Ex-
ecutives, Pittsburgh Chapter (http://
www.scorepittsburgh.com/index.htm)

• The Entrepreneurs Help Page (http://
www.tanned feet.com)

•  Entrepreneurs Guide – Starting a Small
Business in PA (1-800-280-3801)

• Andrew Neft and Mitchell Letwin,
Northwest Mutual Financial Group
(provide insurance and retirement op-
tions for the self-employed)

•  Microsoft Manual of Style for Techni-
cal Publications, a complete guide for
end use documentation

• Developing User Interfaces for Win-
dows, a complete checklist of stan-
dards for user interfaces

•  Microsoft Visual C++ for creating icons

Janis initiated WorkQuest recently by
emailing the listserv to gauge interest and
suggest a meeting. As you might have
learned from the Business Times article, this
group is very active and enthused. Its ob-
jective is to become obsolete as its mem-
bers get jobs. The members are running all
programs, assisting each other to structure
their job searches and share winning tech-
niques and resources.  Job searching is a
full-time job.  And WorkQuest members are
getting jobs and contracts. This SIG is not
registered with STC national.

Notes of the Employment Roundtable, October 8
(continued from page 4)

(continued on page 10)
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WorkQuest Meetings Provide Valuable Information
for Writers, Job-Hunters
By Mary Ann Pike

The Pittsburgh Chapter’s WorkQuest group
continued to meet through September. Janis
Ramey started the WorkQuest group in mid-
August to enable unemployed technical
writers (and friends) to exchange ideas and
job-hunting experiences. At each weekly
meeting, the people who attend talk about
what they did in the previous week to find
employment. In addition, each meeting has
a theme, with one or two members volun-
teering to do a presentation or lead a dis-
cussion on that theme. The goal is to have
different volunteers host each meeting, and
hopefully, to have the membership chang-
ing constantly as some members get jobs
and new members join.

September 3: Portfolios
Nancy Ott started the month off with a pre-
sentation on portfolios. Nancy suggested
having both an on-line and a hardcopy port-
folio. On-line portfolios can be used to show-
case on-line help, websites, etc. You should
have writing samples that can be distributed
on CD-ROM or emailed to prospective em-
ployers. Nancy discussed having several
portfolios targeted toward different indus-
tries or positions (marketing materials, tech-
nical documentation, proposals, etc.). Some
employers ask for send-ahead samples, so
it’s good to have something ready for them.

Nancy stressed that you should save cop-
ies of documents you’ve produced be-
cause future versions of the documenta-
tion may be altered by someone else. She
suggested using excerpts, such as chap-
ters, for your samples, although an on-line
portfolio allows you to present your entire
work in an easy to access format. Here are
some ideas of what should be included:

• Before and after examples

• Source materials and final product
examples

• Awards

• Résumés

• Testimonials

• List of clients

For each portfolio sample, Nancy includes
an abstract that describes the project, how
it was created, and any special challenges
that were involved. She puts each page of
her sample document in a separate sheet
protector so that the document can be read
without pulling it out of the portfolio. Nancy
also has an on-line CD-ROM portfolio. She
has her samples organized by document
type. She provides annotation that de-
scribes each sample in a side frame next to
the sample.

September 12: Coping with
Unemployment
Before the featured topic at the September
12th meeting, Jim McCarty mentioned the
Pennsylvania Professional Employment
Network (PAPEN) group as a resource for
job hunting. They have four meetings a
week throughout the Pittsburgh area, and
have featured speakers who discuss topics
related to career advancement. More infor-
mation about PAPEN can be found on the
WorkQuest website (http://
home.earthlink.net/~workquest/.). Also in
pre-topic discussion, a suggestion was
made that you should copyright your
résumé so that agencies can’t sell you as a
prospective project member to their clients
without your permission, then substitute
someone else. In addition, you should ex-
plicitly state in your inquiry letter to agen-
cies that they cannot send out your résumé
without your approval.

At this meeting, Diana Mathis shared cop-
ing strategies to help you deal emotionally
and physically with your unemployment.
Diana, who has a background in the
healthcare industry, had a wealth of infor-
mation on dealing with the emotional and
physical stress that can occur during long
periods of unemployment. Stress occurs
when we are put in a situation over which
we have no control, or when we feel we
don’t know how to manage the situation.
Long-term stress actually causes health
problems because of the body’s physical
reaction. You can learn to manage your re-

action to a situation, even if you can’t
improve the situation itself. Diana’s sug-
gestions included:

• Remembering who you are, what
you’ve accomplished, what people
think of you

• Maintaining a balanced daily sched-
ule of rest, work, exercise, and leisure

• Developing a means of keeping a
positive attitude

• Being aware of unhealthy coping
mechanisms (drugs, alcohol)

• Expressing yourself creatively (paint-
ing, singing)

• Doing volunteer work, spending time
with supportive people

Diana also provided a list of resources for
dealing with stress and developing coping
skills. The notes from her talk can be found
on the WorkQuest website.

September 17: Cold Calling
Rick Lohmeyer discussed the difficult ac-
tivity of cold calling. Although it is not the
job search technique of choice for many
people, cold calling can result in job leads
and good future contacts. Before beginning
your cold calling, Rick suggests having a
short introductory speech ready. In two or
three sentences, you should introduce your-
self, summarize your experience, and ask if
you can have five minutes of the person’s
time to discuss possible opportunities.

Finding the right person to talk to is one of
the most difficult parts of cold calling. You
almost never want to talk with the Human
Resources department. You should aim to
reach the person who would make the hir-
ing decision for your desired position. A
friend in the company, a receptionist, or
someone in the purchasing department may
be able to supply the name. If the hiring
manager’s calls are screened, don’t say
you’re looking for a job, just say that you’re
self-employed or representing your com-
pany and you can often get through. If

(continued on page 12)
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Notes of the Employment Roundtable, October 8
(continued from page 8)

Miscellaneous Topics — Bob Reitman

By Chuck Lanigan

There are marketable skills that professional
communicators bring to the table (beyond
writing & editing):

• Interviewing skills (vital for task-
analysis, documenting workflows and
knowledge engineering)

• Ability to make connections among
relevant ideas

• Suspension of judgment & gathering
of facts before making decisions

Pittsburgh offers a few unique opportuni-
ties for technical writers and editors in medi-
cine, bio-engineering and related fields):

• Medical writing

• Gathering and documenting statistical
data (for medical and other studies)

• Teaching and training

• Interpreting and writing medical reports
and articles (especially as patient and
public advocates)

Professional communicators contribute
value to their companies and organizations:

• We don’t just write and edit; we solve
communication problems. (Including
reducing information overload and
making efficient use of communication
technologies)

• Companies can pay up front for clear and
efficient writing and document design,
or pay later as a result of poorly-written
and ill-conceived procedures.

• If involved early, professional communi-
cators can apply their skills toward im-
proving product usability, facilitating
clear and efficient communication,
project management testing, training, etc.

Portfolios

By Darlene Mullenix

Why should you have a portfolio?

• It expands on your résumé and your
work experience.

Should I use an on-line portfolio or a hard-
bound copy, or both?

• Both types are useful; let your personal
preference guide you.

• You can use both types.

• If you use both types, be sure they are
comprehensive and mirror each other.

• It is a good idea to have a sample piece
of your best work to leave behind.

How do I start to put together a portfolio?

• What you put in your portfolio is lim-
ited only by your imagination.

• Start by evaluating your work. Make
sure that it is worth including. Remem-
ber: People will evaluate you by what
they see.

• If you’re a student or are just starting,
include samples of student projects,
any volunteer work that you have
done, or personal projects.

• If you have updated a document,
include before and after samples of
the document to demonstrate how
you have improved it. Remember:
Always ask permission to use docu-
ments before you include them in
your portfolio.

• Include a logically-organized and
annotated table of contents.

• List your best pieces first, but save one
best piece for last.

Hard-bound  Portfolio
• Use a professional-looking zippered

portfolio. Include sheet protectors, tabs
and other aids that make it easy for the
reader to navigate through it.

On-line Portfolio
• Use a laptop or a CD-ROM.

• Research the facilities before you go
to the interview. If your portfolio is on
a CD-ROM check with the person in-
terviewing you to be sure that there is
a PC available to use. Otherwise, make
arrangements to bring a laptop.

• Bring batteries to operate your laptop
in case an outlet is not available.

• Test your portfolio on different types
of computers so that you know how it
will be displayed and if you will en-
counter difficulties on a particular PC.

• If you use a CD, make it look attractive.

• Important! Virus scan your CD.

• Make your CD auto run.

• Use a web site to display your portfo-
lio, if appropriate.

• Check for bad links or missing pieces.

• Make sure files are compatible-
Netscape, IE.

• Use HTML or PDF file formats.

• If you use annotated links, give a brief
explanation (what you did and why).

• Make sure that the ToC is available on
every page.

• Use ALT-Tab to toggle.

• Include a documentation plan.

TechComm

Experienced Technical Writer
Experienced Researcher

• Research Proposals

• Grant Proposals

• Contract Proposals

• Research Reports

• Articles

• Monographs

• Training Materials

Telephone: 412-343-2508
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13. Click the Table of Contents tab.

14. Select Simple from the Formats list.

15. Toggle OFF Show Page Numbers.

16. Reduce the number of Show Levels to 1.

17. Click the Options button to view the Table of Contents Op-
tions dialog box. (Fig. 2)

(continued on page 12)

(continued from page 5)

Extracting Document Content—With Style

Fig. 2

By default Heading 1 is identified with a 1 in the TOC level list.

18. Remove the Heading 1 designation and place a 1 in the
TOC level box associated with Requirement.

19. Click OK to close the box. The Index and Tables dialog box
now resembles Fig. 3:

Fig. 3

20. Click OK to generate the table of contents. Your document now
displays a field code representation of the table of contents—
something like this:

{TOC \n \p “ “  \t “Requirement,1” }

21.  Select Tools > Options > View from the main menu.

22. Toggle OFF the Field Codes and Hidden Text options. This causes
the RD field code line to become hidden and the table of con-
tents field code to transform into the referenced paragraphs:

REQ-1001-022 Requirement text goes here; apply
“Requirement” style.

REQ-1001-023 Requirement text goes here; apply
“Requirement” style.

REQ-1001-024 Requirement text goes here; apply
“Requirement” style.

All of the requirement paragraphs appear in the same sequence as
they appear in the original document. The requirement numbering
has no effect on how the requirements are ordered here.

Notice in the example above that the tab character between the
requirement number and requirement text was retained. Because
the tab is there, you could highlight all of the requirements, copy
them to the Windows clipboard, then paste them into an Excel
spreadsheet for additional processing. Excel will recognize the
tab character as a delimiter and will place the requirement number
in one column and the corresponding paragraph text in the ad-
joining column. Of course, each requirement paragraph becomes
its own row in the spreadsheet.

Maintaining this document after changes occur in the requirements
specification is simple:

1. Highlight the entire list of requirements.

2. Right-click and select Update Field from the shortcut menu:

Fig. 4
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Word regenerates the entire table of con-
tents, replacing the old requirement text and
numbers with new requirement text and
numbers.

Using Word’s styles and the table of con-
tents generator, you can extract any num-
ber of items from one or more documents,
regardless of how interspersed those items
may be within those documents.

Bob Mohr can be reached at
rpmohr@writemohr.com

Extracting
Document
Content—With
Style
(continued from page 11)

you get the hiring manager’s voicemail,
leave your introductory speech and phone
number. If they are interested enough to
call you back, then they are probably a
good prospect.

Rick keeps a database of contact informa-
tion for all of the people he calls: the com-
pany, the contact person’s name, position,
and phone number, and how much interest
they showed. Remember that when you’re
cold calling, you’re a telemarketer, and we
all know how we feel about telemarketers!
Be polite and to the point. Ask if they have
a few minutes to talk, or if you could call
them back at a more convenient time. Don’t
call on Monday mornings or Friday after-

noons.  Good times to call are usually 9:30
to 11:00 a.m. and 2:00-3:00 p.m.

Do some research on the companies you
contact. You can get company names and
information from the Pittsburgh Technol-
ogy Council (PTC), Pittsburgh Business
Library, Thomas Registry, Chamber of
Commerce, and Carnegie Library website,
among other resources. Look for articles
about the companies in the local papers
and look at their websites. Rick usually
looks for companies of 30 people or more
to indicate some stability, but others said
they have worked for much smaller com-
panies that often don’t have their own
writer and will hire freelancers.

September 24: Healthcare Coverage
Diana Mathis and Dennis McCarthy gave
an informative talk on the different ways
you can find health coverage when you are
unemployed. A rule of thumb is that basic
benefits should cover 75% of the expenses
for illness and injury. Depending on your
family situation, they suggested seeing
whether two individual policies might be
cheaper than one single policy.  Keep in
mind that you may incur significant ex-
penses if you have a pre-existing condition
and you change insurance coverage.

There are many local options for purchas-
ing group insurance. The Small
Manufacturer’s Council (SMC) and the PTC

Employment Issues: Interview Tips

brings up these issues, don’t give a spe-
cific amount. Keep focused on the company
and the position. It will leave a better im-
pression with the interviewer.

Use the PAR method
When answering behavioral-based interview
questions, use the PAR method.

• Problem -  Consider the problem cir-
cumstance and explain it and provide
background information.

• Action  - Describe what steps you took.

• Result - Describe what occurred be-
cause of your actions.

Send a follow-up letter
Send a brief letter or e-mail to your inter-
viewers to thank them for their time and to
express your continued interest in the po-
sition. Make sure you spell their names
correctly. It is also a good opportunity to
overcome any objections, stress your skills
and reaffirm your interest in the job.

(continued from page 7) Pam Schmidbauer is Area Manager of
Aquent’s Pittsburgh office and can be
reached at pams@aquent.com or 412-
322-4940. Aquent (aquent.com) is a
global professional service firm deliver-
ing Creative and IT solutions. Through a
network of nearly seventy offices in
twelve countries, Aquent provides
staffing, consulting, and outsourcing
services in the areas of print and Web
design and production; application and
database development; and project
management. In its fifteen-year history
Aquent has made over 200,000 matches
of independent professionals with client
companies worldwide. Aquent is
headquartered in Boston, Massachusetts
and is privately held.

Pam Schmidbauer, Associate Area
Manager, Aquent 3445 Butler St.
Pittsburgh, PA 15201, Tel. 412-322-4940
| Fax. 412-322-4950

AIGA | American Institute of Graphic
Arts, Pittsburgh Chapter, Board Member.
Web site: www.aigapgh.org

WorkQuest Meetings Provide Valuable Information
for Writers, Job-Hunters

(continued on page 13)

(continued from page 9)
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(continued from page 9)

WorkQuest Meetings Provide Valuable Information
for Writers, Job-Hunters

both offer group policies to members;  many
chamber of commerces do the same.
Highmark directly offers group insurance.
Pennsylvania offers insurance depending
on your income. There are two different pro-
grams for adults (Adult Basic) and children
(CHIP). COBRA is available to people who
are laid off, but is usually very expensive.

October 1: Working with Recruiters
Marsha White and Dennis McCarthy pre-
sented information about working with re-
cruiters and agencies. Marsha White asked
a recruiter she knows to give her some rea-
sons why you should work with a recruiter.
The recruiter’s responses included:

• Recruiting firms have relationships
with existing clients

• Recruiters can sometimes find short-
term work for you to keep you going
until you find a full-time position.

• Recruiters talk directly to hiring man-
agers and can get your résumé past
the Human Resources department.

• Recruiters will handle problems that
may come up with the management at
the company where they’ve placed
you, and salary negotiations.

• Recruiters know more information
about a position than an advertisement
usually provides.

Other suggestions included:

• Develop a relationship with some re-
cruiters before you lose your job

• Ask friends for names of recruiters
they’ve worked with

• Make sure the recruiter understands
your concerns (e.g., confidentiality)

Some negative points that were made:

• 90% of people find their jobs through
networking, and only 10% by inter-
viewing with companies where they
have no connections.

• Recruiters often don’t want to work
with unemployed people or new gradu-
ates because they are less attractive to
employers.

• Recruiters can’t help you change ca-
reers, they can just find you a new po-
sition in your current line of work.

Care should be taken when working with
firms with whom you are not familiar:

• Avoid firms that want to charge for cre-
ating your résumé or helping you
search for a job.

• Avoid firms that charge for placing you
or have a clause that requires you to
pay the placement fee if you leave the
company before a specific amount of
time has elapsed.

• Don’t give references to a recruiting
firm unless they have scheduled an
interview for you and need to give a
company the references. Recruiters
may call the managers you gave as ref-
erences and try to get them to hire other
clients.

• Don’t give out any personal informa-

tion (like your social security number)
unless you absolutely must (e.g., when
filling out an employment application).

Dennis McCarthy discussed his experi-
ences working with agencies. He said that
you should find an agency that specializes
in the type of work you are seeking. You
can use an Internet search to find agencies
and do on-line research on their businesses.
A recruiter gave him some advice on how
to get noticed when you apply for a job:

• Get your résumé noticed by using an
8x10 envelope and overnighting it. It
shows that you have put some effort
into delivering your résumé.

• Send in your résumé using multiple
methods. Email, fax, and mail your
résumé if the company gives you all of
those contact methods.

• When sending a résumé through email,
put something catchy in the subject
line like “referred by so-and-so,” a sum-
mary of what you bring to the job, or a
summary of the job posting.

To find someone who specializes in your
industry, you may need to work with a re-
cruiter in another part of the country. Den-
nis found a recruiting firm in Oregon that
places technical writers in Silicon Valley.
They have an interesting statement on their
website that says because of the current
economic condition, they are only working
with writers that have uncommon skills, but
you can send your résumé to them and they
would be glad to critique it and return it to
you as time permits. More information about
working with recruiters can be found on
the WorkQuest website.

WorkQuest was formed as a resource for
you. Although the meetings are geared to-
ward writers, everyone who is looking for
work is welcome to attend the meetings.
Many interesting topics are planned for the
next month. Notices of the meetings can be
found on the WorkQuest website:

http://home.earthlink.net/~workquest/.
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STC Chapter Meeting Schedule
Mark your calendars!  Here are topics and
tentative dates for the remainder of the
2002-2003 meeting calendar.  More details
on each meeting will be published as the
dates draw closer.

2002:
November 6 (Wednesday) — Quadralay
demonstration (Andy VanConas)

December 7 (Saturday) — Usability lab
(Mike Bates); Joint chapter meeting with
Cleveland in Youngstown OH

2003:
January — Winter Party (date to be deter-
mined)

February 11 (Tuesday) — Frame 7 (Kay
Ethier)

March 11 (Tuesday) — Chapter 50th Anni-
versary Party and Awards Banquet (Janis
Ramey)

April 8 (Tuesday) — Robohelp (Leslie
Johnson)

May — Spring Fling Party (date to be de-
termined)

Quadralay Webex Demonstration,
November 6
The Pittsburgh chapter meeting will feature a software demonstration by Quadralay. Join
us on Wednesday, November 6 in the training room at the Pittsburgh Technology Council.

Independent and Lone Writers SIG November Meeting
The next meeting for the Independents and
Lone Writers SIG will be Tuesday, Novem-
ber 19 at 6 p.m. at the Church Brew Works
on Liberty Avenue.  This month’s meeting
is a happy hour/networking meeting with a
discussion on how to get free press to mar-
ket your business.

One key issue that independents face is
marketing.  Not all marketing has to be
costly; it is a matter of targeting the right
publications and other media and taking
advantage of public relations opportunities.
The meeting discussion will focus on some
of the trade publications in the Pittsburgh
area and other media outlets and how to
effectively use them to promote your busi-
ness.  Everyone is invited to bring some of
their own experiences about working with
publications and the media and some tips

on how to get your name and business in
print without a huge expense.

The cost of the meeting is $7 and includes
the Church Brew Works famous pizza and
veggies; drinks are on your own.  Please
RSVP by Monday, November 18 to Barb
Stanton at Bstanton@seec.com or call (412)
893-0383. For directions and information
about the Church Brew Works visit
www.churchbrewworks.com.

Article Deadline
The deadline for the next issue of the Blue
Pencil is Thursday, November 7.  Please
send your submissions to Meg Papa at
mv0t@andrew.cmu.edu.

WHEN:  Wednesday, November 6,
2002, 6:30-8:30 pm.

WHERE:  Pittsburgh Technology
Council Training Room, Second
Floor.

COST:  No cost. light refresh-
ments will be served.

RSVP:  Please reply by Friday,
November 1, 2002 to Darlene
Mullenix by emailing her at:
dmullenix@federatedinv.com
or calling at: 412 288-8676. Include
your telephone number.

Reminder: 2002 Region 4 Conference
The Central Ohio Chapter of the STC is
hosting the 2002 Region 4 Conference on
November 8 and November 9, 2002.

The Leadership Conference will be held on
Friday afternoon, November 8, 2002 at
Chase Manhattan Mortgage Corporation
in Easton, OH. The Region 4 Conference
will be held on Saturday, November 9, 2002,
at Columbus State Community College.

The half-day Leadership Conference is $50
for non-members, $40 for members, $35 with
corporate discount (3 or more from the same

company), $20 for students. The Region 4
Conference is $95 for non-members, $85 for
members, $75 with corporate discount, and
$25 for students. To attend both the Lead-
ership and Region 4 Conference, the costs
will be: $135 for non-members, $115 for mem-
bers, $100 with corporate discount, and $30
for students. For more information, contact
Brenda McGuire at mcguireb@battelle.org
or Sue Wolford at sue.wolford@chase.com,
or visit our conference Web site at:
www.centralohiostc.org/region4conf.

The name of the SIG has changed to in-
clude Lone Writers.  There seems to a large
number of lone writers in companies, as a
result of budget constraints and a change
in the corporate atmosphere.  If you are a
lone writer, please join us at our meetings
to be among others in the industry.  Also,
any suggestions on meeting topics or ven-
ues are always welcome.  Simply send an
email to Barb Stanton
(Bstanton@seec.com) with the information.
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